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Copyright Information

All rights reserved. No part of this publication may be reproduced, transmitted, stored in a
retrieval system, or transiated into any language in any form by any mcans, mechanical,
optical, electronic, recording, or otherwise, without the written permission of Mustek,
Incorporated. ’

Mustek Incorporated reserves the right to revise this manual and to mpake changes to any or
all parts at any time, without obligation to notify any person or entity of such revisions and
changes.

Mustek is a registered trademark of Mustck, Incorporated. All other brand or product names
mentioned in this manual are trademarks or registered trademarks of their respective
owners.

Copyright © 1948 Mustck, Incorporated.
Printed in Taiwan, May 1998,

FCC Statement

This digital equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant 1o Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
residential installation. This equipment generates, uses, and can radiate radio frequency
cnergy and if it is not installed and used according to the instruction manual, it may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not oceur tn a particular installation. 1T this equipment causes harmful
interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged 1o try to correct the interference by one or more of
the following measures:

+ Reorient the receiving antenna
+ Increase the distance between the equipment and the receiver

+ Connect the equipment into an outlet on a circuit different fram that to which the receiver
is connected

* Consult the dealer or an experienced radie/TV technician for help

NOTE

I. The changes or medifications not expressly approved by the party responsible for
compliance could void the user’s authorily to operute the equipment.

2. Shielded interface cables and AC power cord, if any, must be used in arder to comply
with the emission limits.
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Installation

This chapter covers the scanner parts and describes how to connect
the scanner to your computer and printer. You will also find
information about the operation of the scanner,

>

Unpacking the Scanner Package

Carefully unpack the contents of the scanuer package. Inspect the
items closely and if you find any item damaged, please contact your
dealer immediately. Also, save the box and packing material for
future usc in case you have to ship the unit.

The Scanner Parts

:

== Document Cover

— Scanner Glass

The Flatbed Stanner {Front)

7 Power Cord
: —l—% Receptacie

~—

T Printer Port

Computer Port
The Flatbed Scanner {Back)
Instaliation 1-1
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Connecting the Scanner to the PC and Printer

Refer to the following illustration and sleps 1o install your scanner.

Computer
»

Priuter Scanner

Power off the computer and any devices that are connected to it
{e.g., monitor, printer, modem),

Disconnect the printer cable from the printer port in the back of
your 'C.

Take the disconnected end of the printer cable and attach it to the
portin the back of the scanner marked Printer, Tighten the
retaining screws.

Connect one end of the scanner cabie to the printer port in the
back of your PC and tighten the retaining screws.

Connect the other end of the scanner cable to the port in the back
of the scanner marked Conmiputer,

Connect the power adapter to the scanner and plug it into an
appropriale power outlet.

Power on the computer and wait for the computer to finish
booting.

Instail the scanner driver and software by referring to the next
section.

Flatbed Scanner User's Manual
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Installing the TWAIN Data Source

Windows_ 95/NT Route

Begin by inserling the
Mustek 1200 L1 CD.

Follow all on-screen instructions.

Note: if on-screen instructions do not
appear, please refer to the Jollowing:

Click on “Start”
and sefect “Run”,

In the “Run” dialog box, type
“driveiund, where drive is YOur

CD-ROM drive and click “OK.”

oo
e

LSRN e T N M TR

Follow all on-screen instructions,

Windows 3.1x Route

Begin by inserting the
Mustek 1200 LP CD.

From Program
Manager, click on
the “File” menu
and select “Run”,

In the “Run” dialog box, type
“drive\run” where drive is your
CD-ROM drive and click “OK.”

Comundd Lina

Dun .

[ Hon pmarnd

Follew all on-screen structions.

Note: Do not use the "add hardware” icon to install your scanner.

Installation 1-3
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Scanning Tutorial

This chapter shows you how to: 2
1. Get (Acquire) and Use the Scan Dialog Box

2. Get (Acquire) and Use the TWAIN Dialog Box
3. Perform a Simpile Scan

4. Position a Document

5. Scanning Tips

There are two separate methods to scan an image: the Scan dialog
box, which is ideal for quick and simple scans and the TWAIN
dialog box, which offers more control over the cutput.

& Get (Acquire) and Use the Scan Dialog Box

)

(For Windows 95 & Windows NT Only)
You can access the Scan dialog box in two ways.

1.The Direct Scan Icon: Simply double click the left
Mouse Button on the Direct Scan icon that is located in your
Windows notification bar,

2.The Cover Sensor Dialog Box: This scanner js equipped

with a Cover Sensor feature that takes you directly into
scanner access mode. Simiply lift the cover of your scanner
and the Cover Sensor dialog box will appear. To proceed to
the Scan dialog box, click "Conlinue".

%i\q\ ot i

ot

This Cover Sensor dialog box can be disabled by selecting
the disable feature. By doing this the Cover Sensor takes
you directly to the Scan dialog box, bypassing the Cover
Sensor dialog box. To re-enable the Cover Sensor dialog box
click the right mouse button while on the Direct Scan icon in
your Windows Natification Bar. A pop-up menu appears
allowing you to re-enable the Cover Sensor dialog box as
well as disable or re-enable the Cover Sensor feature.

Scanning Tutoerial 2-1
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The Scan Dialog Box

..

The Scan dialog box aliows you to perform several functions using
your scanner (e.g. scan, copy, fax). Simply select the function that
you wish 1o use by clicking on the appropriate icon and the corre-
sponding menu page will appear. Be sure to make the proper adjust-
ments in regards to Paper Size, Scan Mode, and/orResolution
hefore Scanning, _ |__‘;,11‘,ﬂ.

i1Scen the imape Lo the compuber,

T
Menu Page Browser lcon

Secan:
Scans the image or document to the computer,

Copy:
Copies the image or document.

Fax:
Scans and faxes the image or document.

E-Mail:
Scans and sends the image or document to the Internet

OCR:
Converts the image document to a text file

2-2 Flatbed Scanner User's Manual
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Sean:

Scans the image or document and allows for various features
depending on the Scan Menu Page that you are currently in. ;
Copies your image or document to your printer in Copy. 1
Faxes your image or document in Fax.

E-mails your image or document to the internet in E-mail.

Scans the document for editing into your OCR software in OCR.

Exit:
Exits the program.

Help:
Offers available on-line help for all of the scanner and software
functions.

About:
Shows product information.

!‘.r.k.

The Browser Icon: This icon allows you to select the software
application you would like to open the scanned image into,

4
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@ Get (Acquire) and Use the TWAIN Dialoé Box

2-4

You can call up the TWAIN dialog box {from within any TWAIN-
compliant sofiware such as the application software bundled with the
scanner. To pet into the TWAIN dialog box, the steps are:

1. Launch Windows,

-
-

2. Launch the TWAIN-compliant program {(e.g. Micrografx Picture
Publisher).

3. Under the File menu open the Acquire command and choose
Select Source. The Select Source dialog box appears.
Nete: In some image editing software you may choose Select
Seource divectly from the Select Source command rather than the
Acqitire commund.

WMUSTER, 1200 LP - o

-
|

4. Choose your scanner in the Select Scurce dialog box. If there is
only one source available, it is automatically selected.

5. Click the Select button. The Select Source dialog box closes.
6. Retumn to the File menu. Locate and click the Acquire command.
The Acquire command is likely to be found beside the Select

command.
The TWAIN dialog box appears.

Flatbed Scanner User's Manual
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The TWAIN Dialog Box

Batch Scan Button Single Scan Buttoen Zoom Buttons
Allows creation of up o Allows only cne Magnifies or
10 scan regions (or Crop Crop Frame or scan shrinks the image

Frames) for multiple region. in the Preview

scanning.

Scanner
Controls]|

Window.

Language Box
Selects the
language

Exit

Exits the
program

Descreen Button Crop Frame
Reduces image Preview Qutlines the image area or
noise or patterns,  Window region that will be included in

the final scan.

The TWAIN dialog box consists of two sections - the left section
where most of the TWAIN control settings are found and the right
section, which is the Preview window.

Scanning Tutorial 2-5
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@ Perform a Simple Scan

2-6

The steps to follow when scanning are:
“+—5elest-lhe-soan-sizen

Prescan the image.

Using the crop frame set the desired scan imagg size.
Select the desired scan mode.

Select the desired resolution.

Click on the Scan button.

R NS

These steps are explained in detail in the following sections.

Select the Scan Size P

From the listof nuaﬂable paper. sizes;] se]ec,l the size of the document
you wish to scan, Customwill automatically be selected when you
_use e Crop Frame to change the image area fo be SCEI.'LU]CL

Prescan the Image

A Prescan is a quick low-resolution scan of the entire original image.
From this low-resolution scan you can get a clearer idea of the image
area you want to include when you click Scan. To prescan, the steps
are:

b, Place the document face down on the scan window glass,

2. Click on the Prescan button. After the scanner has scanned the
document, the scanned image will appear in the Preview Window.

From the Prescan image, you can now set the exact image area you
wish to mclude m your final scan.

Set the Image Size

Use the Crop Frame in the Preview Window to outline the image area
you wisl: to scan. Click one of the sides or corners of the Crop Frame
and drag it to the desired length and width. To move the entire Crop
Frame, position the mouse cursor inside it and drag with the (left)
mouse button. Only the area inside the Crop Frame will be included
in the resulting scanned image when you click on the Scan button.

Flatbed Scanner User's Manual
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Using the Zoom Tools

The Zoom [ tool doubles the magnification of the image area. In
magnified view, you can then drag the Crop Frame to the exact area
you wani o scan. Use the Zoom Out tool to shrink the image.

Set the Scan Mode

The Scan Mode determines how the scanner will redd the image.
Select Color to capture images in color. Select Gray to capture
images in shades of gray. When you wish to scan line art or text for
OCR (Optical Character Recognition), select LineArt.

Set the Resolution

The Resolution, which is measured in dots per inch (dpi) determines
the cffect of the image as it is displayed or printed. Images scanned at
a high resolution appear sharp since the scanner is capturing more
infermation but take note that high resoiution images also take up
more disk space for storage.

Execute the Scan

The scan button is used once you have completed the prescan

and are finished with the control settings and have selected the final
image adjustments that are to be used for this scan,

Note: To further adjust your image before scanning see Chapter 3
(The TWAIN Dialog Box) for enhancement and filter details.

Scanning Tutorial 2-7
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@ Position a Document

For the best possible image scans, it is important that you position
your documents correctly and carefully.

1. Lift the document cover,

2. Place the document face down on the scanner glass and in the
. upper right comer where the alignment marks are located:

3. Slowly lewer the document cover, making sure the document
remains in position.

4. In your scanning program, sct up the scanning parameters such as
scan mode and resolution.

5. Ixecute the scan command,

6. Remove the document after scanning is complete.

2-8 Flatbed Scanner User's Manual
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€ Scanning Tips

The following tables provide helpful information you can use when
setting the scan mode and/or resolution. Recommended scanning

resolutions for various output devices are listed as follows:

»

. . Suggesnted .
PrinterType | InpuiMaterial Scan Mode Resolution
600-dpi Laser or Color Grayscale 150dpi
Irkjet Printer Grayscale Grayscale 150dpi
Line Axt Line Art 600 dpi
200-dnil. Coloy Grayscale 150 dpi
Inl;' plp aser or Grayscale Grayscale 150 4dpi
Jet Printer Line Art Line At 300 dpi
Check with
Color GxC°1°:l GICOIG:I marafactwerfor
- Inkjet Printer ‘aysz * ayscale recormmended
Line &yt Line Art resolution
Dye Sublimation Color Color Sean at r;:xl
or Color Grayscale Grayscale |Fom o ,twﬁ
LaserPrinter Line Art LineAst |cfprinterina
rodes
Space requirements for different scan modes:
4 x e 100 dpl 150 dps 300 dpi 600 api
Image Scan P P P P
Gray 234 Kb 527 Kb .06 Mb 824 Mb
Cdlor 703 Kb 1.54 Mb 6.18 Mb 24,7 Mb
Legal Slze
Document Scan 206 ¢pt 300 dp1 400 dpi
Line Arl/Text 570 Kb 1.25 Mb 222 Mb
Scanning Tutorial
A
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The TWAIN Dialog Box

The TWAIN dialog box is part of the scanning module provided with
your scanner. TWAIN is an industry standard that allows scanning
directly into any TWAIN-compliant software. It eliminates most
compatibility problems associated with software anfl input devices
supplied by different vendors. :

You can ¢all up the TWIAN dialog box from within any TWAIN-
compliant software such as the application software bundled with the
scanner (e.g. Micrografx Picture Publisher). If you are not continuing
from the Scanning Tutorial please refer to Chapter 2 (Pg. 2-4) “How to
Get (Acquire) the Twain Dialog Box” before Proceeding,

i
Scan Mode .

~Sgan Souce

Scan Sizo., .

Resalulion -

i 1 Imaga Sizo

sDoscieen

The TWAIN dialog box consists of (wo sections - the left section
where most of the TWAIN control settings are found and the right
section, whiclh is the Preview window.,

To Prescan an image, please refer to Chapter 2 (pg.2-6) “Performing a
Simple Scan™.

The TWAIN Diafog Box 3-1




The Preview Window and Buttons

The Preview window is where you can view the prescan image. The
first time you want to scan a decument, it is better that you do a
prescan. With the prescan image, you can then specify the final image
area to be included in the actual scan and/or apply the TWAIN image-
enliancermnent commands and filters.

Crop Frame
Outlines the scan
area or region that
will be included in
the final scan.

*« Help
Provides on-line help for the scanner and software functions.

+ Language Icon
Selects the language you would like to view the screen in.

+ Exit Ieon
LExits the prograni.

* Prescan the Image
A Prescan 1s a quick low-resolution scan of the entire original
image. From this low-resolution scan you can get a clearer idea
of the nmage area you want to include when you click Scan. To
prescan, the steps are:
1. DPlace the document face down on the scan window glass.
2. {Click on the Presean button. After the scanner has
scanned the document, the scanned image will appear in the
Preview Window. From the Prescan image, you can now set
the exact image area you wish to include in your final scan.

Flatbed Scanner User's Manual
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Scean

When you click on the Scan button, the Scanner dialog box
displays the progress of your image transfer. When scanning is
over, the image will be displayed 1 the main screen of the host

“software behind the Scanner dialog box. This provides the option

of doing additional scans without re-acquiring the Scanner dialog
box each time. :

Single Scan Button

When this button is selected, you can only have one Crop

Frame (or rectangle) in the Preview window. With the Crop
Frame you can outline the image area you wish to scan. Click one
of the sides or carners of the Crop Frame and drag it out or in to
the desired length and width. To move the entire Crop Frame,
posttion the mouse cursor inside it and drag with the left mouse
button.

Batcl Scan Button

Clicking on this butten allows you to have multiple scans on any
part of your document using different control setiings. A dialog
box opens. Please refer to the section, Using Batch Scan found in
this chapter (Pg.3-10) for more details.

Using the Zoom Tools

The Zeom In tool doubles the magnification of the image
aren. In magnified view, you can then drag the Crop Frame
to the exact area you want {o scan, Use the Zoom Out tool
to shrink the image.

The Image Setting Buttons

The Image Setting Buttons allow you to create scan settings for your
own convenlence. Saving image settings ailows you to use the same
scttings again and again without the hassle of resetting all the image
options.

Load Button
Loads previously saved settings.

Save Button
Saves current image settings to a file.

The TWAIN Dialog Box 3-3

w2

5

-

R S




.
RGD

Previous Button
Reloads the last saved image setting.

Reset Button
Returns the image settings to their default vaiues.

Information Button 2

Simultaneously shows the current cantrol settings from all the TWATN
folders.

TWAIN Control Settings

3-4

The Main Folder

The Main folder contains the control settings needed for specifying the
scanning parameters such as scan mode, scan source, resolution, etc.
These parameters will determine how the original image or document
will be scanned, displayed or printed.

Scan Mode

The Scan Mode determines how the scanner reads the original image
or document. When choosing a scan mode, it is wise to consider what
purpose the resulting scanned image will be used for.

Flatbed Scanner User's Manual
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» Cuolor
seleet Color to caplure images in colors. Our Color mode
generates 36-bit (68.7 billion colors) inlernal images and
24-bit (16,7 million colors) external mages.

* Gray
Select Gray to capture images in shades of gray. Qur Gray
mode generates 12-bit (4096 shades of gray) internal images
and 8-bit (256 shades of gray) external images.

* LineArt
Use this mode to scan text documents for use in QCR
(Optical Character Recognition) or when you wish to scan
black-and-white drawings.

Note: Internal images refer 1o images that are originally
captured by the scanner. External images refer 1o images that
are transferred to the computer,

Scan Source
The Scan Source setting is used to select the type of document you
will be scanning.
*  Reflective
Use Reflective when you wish to scan a paper-based
document such as photographs or text,

Select the Scan Size

Fron the list of available paper sizes, select the size of the document
you wish to scan. Custom will automatically be selected when you
use the Crop Frame to change the Image area to be scanned.

Resclution

The Resolution, which is measured in dots per inch (dpi) determines
the effect of the image as it is displayed or printed. Images scanned
at w higher resolution appear sharp since the scanner is capturing
more information but also take up more disk space for storage. You
can seleet from a wide range of preset resolutions,

The TWAIN Dialog Box 3-5
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3-6

Output Scaling
Output scaling allows you to enlarge the size of the final output image,

For example, setling the Output Scaling to 200% will enlarge the output
image four times its original size.

Width and Height

The Width and Height values show the dimensions of the image area
inside the Crop Frame in the Preview window. You can change the
Measurement unit w centimeters, inches or pixels.

Image Size

Image Size displays the amount of computer memory or disk space
needed to display or suve the image outlined by the Crop Frame in the
Preview window. The Immage Size information is automatically updated
anytime you change any of the control settings or resize the Crop Frame.

&=

i

Desereen
Descreen is a useful tool for reducing moiré patterns in
scammed images of ariginals that were created by a halftone

process. Moir¢ patterns appear as unsightly interference
patterns.

Flatbed Scanner User's Manual
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The Enhancement Folder

The Enhancement folder contains preprocessing controls you can
apply to the image before making your final scan. Using these
preprocessing controls, you can alter the appearance of the final
cutput image. To view the Enhancervent folder, click the Enhance tab.

Thumbnails

The Enhancement folder contains two thumbnails of the prescan
image, scveral control settings, and a histogram of the image. Changes
you make to the control settings will appear in the sample thumbnail,
If you wish to chunge the image that appears in the thumbnails, drag
the Crop Frame in the Preview window,

I you wish to sce the effects of your changes in the Preview window
image, click on the Preview button,

»  Channel Selector
Channel refers to the red, green, and blue layers that make up
a color image. You can choose to change the channels
individually or choose Master to change all channels equally
and sinultaneously. An image in Gray Mode has one channel,

»  Brightness Control
The Brightness centrol allows you to adjust the overall
amount of light in the image.

The TWAIN Dialog Box 3-7
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3-8

Contrast Control
The Contrast control allows you to adjust the overall amount
of white and black in the image.

Gamma Control

The Gamma control is used for adjusting the brightness level
in the highlights, midtones, and shadows of the image. Values
of 0.1 to 2.0 primarily affect the shadow areas of the image,
Values of 2.1 to 6.0 primarily affect the midtone areas, and
values of 6.1 to 7.9 primarily affect the highlight areas.

Histopram Button

The histogram shows the distribution of the brightness levels
in the image. To adjust the display of the histogram, click on
the Histogrambutton and then click on the + or - button.

Preview Button
Click the Preview button to see any changes made to the
image. The changes will appear in the Preview window image.

The Filters Folder *@*}

The Filters folder contains preprocessing controls that allow you to
apply special cffects to the image before making your final scan. To
view the Filters folder, click the Filters tab.

Mard/ ! Enhance - | fFiltan | Abcut Y

A

The Filters folder contains two
thumbnails of a sample image. Any
filter you choose will immediately
show its effect in the sample thumb-
nail,

Flatbed Scanner User's Manual
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* None
The None setting means no filter is applied. This is the
default sctting.

* Blur
The Blur filter (controiled with the plus and minus buttons)
smoothes the image by lightening the pixels that are in sharp
contrast to their neighboring pixels. '

* Sharpen
The Sharpen filter (controlicd with the plus and minus
buttons) erhances the detail in blurry images by improving the
focus and increasing the contrast in the inrage.

* Invert
. The Invert {ilter reverses an image to its negative or
compliment.
« Flip

The Flip filter creates a mirror image of the ariginal by
\ flipping the image horizontally.
-
*  Emboss
The Emboss filter makes the elements in an image appear
raised or sunken.

*  Unsharp Mask
‘The Unsharp Mask filter detects sharp edges and colar
boundaries and then emphasizes them.

About Folder

The Aboul folder containg the current driver version number and the
copyright notice, To view the About folder, click the About tab.

The TWAIN Dialog Box 3-9



Using Batch Scan

3-10

Batch scanning is an casy way to multi-scan any part of

your document using different scan modes and resolutions (however,
certain application programs do not support this function). In batch
scanning, you can specify up to a maximum of 10 scan regions or you can
scan a single region several times using different combmatlons of scan
moedes and resolutions.

To do a batch scan, the steps are:

I Click on the Batch Scan button, The Bateh Scan dialog box appears.

b2

Create a scan region:

{a) Move the cursor inside the preview window.

(b) Hold down the Shift key, press the left mouse button and drag
the mouse o create a crop frame.

(c) Reposition or resize the crop frame if necessary.

3. Set the desired scan mode and resolution for the current scan
region.

4. Repeatsteps 2 and 3 if you wish to create more scan regions. You
can have up to 10 scan regions,

5. Click Scan. The scanner will begin to scan the scan regions one
after the other.

Flatbed Scanner User's Manual
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Appendix A: Specifications*® -

Scanner Type Flatbed
ScanModes True Color:
Gray Mode:

Text/Line Art;

36bits (internal), 68.7billion colors
24bits(external), 16.7 miilion colors
12bits ({nternal), 409 shades of gray
& bits (external), 256 shades of gray

I bit/pixel{2 levels)

ScanMethod 1 scanning pass

Scun Area 216x350mm

{(maximum) 8.5"x 14"

Resolution Optical: 600 dpi (H) x 1200 dpi (V)

Maximum: 9600 dpix 9600 dpi (through software interpotation)

Resolution Control 72 - 9600 dots per ingh {(dpi) (contrelled by software)

Scanning DataBuffer  128KB(maxinmun)

Gamma Correction Downloadable by software

Brightoess Control 255 adjustable steps (software controlled) '(‘~"f"
Contrast Control 255 adjustable steps (software controlled)

Interface pp

LightSource Cold Cathode lamp

Dimensions 556mmx 306mmx 102mm(Lx Wx H)(18.5x11.7x 3.9 inches)

Weight 3.8kg (8.361bs)

Voltage Requirements 100 Vac~2350Vac,47~63 Hz

Power Consumption Linear Adapter 1.OA, 15W

OperatingTemperature 10 to 40 degrees Centigrade (50 to 104 degrees Fahrenheit)

Operating Humidity 35% to 80% RH, noncondensing

Storage Temperature  -10 10 60 degrees Centigrade (14 to 140 degrees Fahrenheit)

Storage Humidity 20% to 8% RH, noncondensing

* Product specifications are subject to change without notice,

Appendix A-1
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Appendix B: Technical Support

Mustek, Inc. Mustek Computer GMBIH Mustck Systems, Inc.

121 Waterworks Way, Suite #100 Hellersbergstr. 2a No. 25 R&D Read 2
Irvine, CA 92618 41460 Ncuss Science-Based Ind'| Park
USA S Germany Hsinchu, Taiwan, R.O.C.
TEL: E-.'f—l'ﬂ_—?HE—JGOO TEL: 49-2131-162840 TEL: 886-3-5779373
FAN: 1-7134-788-1670 FAX: 49.2131-103830 FAX: 886-3-57841139
24-hour BBS[JMJSS-JG.!O BBS:49-2131-167104 http://www.mustek.com.tw
http/www. mustek.com BBS:49-2131-130052

http://www.muslek-europe.com

To bring you the best possible service, please have the foilowing information
ready when you call:

* Which scanner model do you have?

* Which computer model are you using?

- What version of scanning software do you have?
* What other application programs arc you usmg?

* What other components are in your system? {For example, FAX card, sound
card, SCSI card and so on.)

* What are the problems/symptoms you encounter? ol
Product Repairs

For Product repairs please follow these steps:

1. Call the technical suppert department for a Return Material Authorization

(RMA) number and refer to this number in all future calis.

2. Consultyour dealer regarding proper repair procedure,

3. For repairs being shipped to the manufacturer, please write the RMA
number clearly on the outside of the package and send it postage paid,
prepared and packaged appropriately for safe shipment.

Product Rctux:ns B

* Users must return the products to their point of purchase for a refund or
credit, according to the dealer's policy.

Flatbed Scanner User's Guide







